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1 Introduction

CMacTEX is an implementation of TEX for the Macintosh which includes TEX, e-TEX,
pdfTEX, Metafont, dvips, macdvi, a Postscript previewer, a Postscript converter, and several
utilities for manipulating TEX fonts, Postscript files and Postscript fonts. CMacTEX also
includes bibtex, makeindex, dvipdfm, and metapost. CMacTEX can be configured to work
in an integrated fashion with BBEdit and Alpha. It will run on any PowerPC Macintosh
with 32 MB of free RAM (64 MB recommended) and Mac OS 8.1 or later. The Carbon
version of CMacTEX requires at least Mac OS 8.6 and CarbonLib 1.0.4 and runs natively
on OS X.

• CMacTEX is the only implementation of TEX for the Classic Mac OS that includes
dvipdfm and pdfTEX.

• The new CMacTeX program is the control center when typesetting a document.
From it you issue commands to typeset the document, using either tex or pdftex,
to convert dvi files to Postscript, to make indices and bibliographies, to convert
Postscript to PDF, and to view dvi, Postscript, or PDF files.

• CMacTEX is based loosely on the web2c 7.3 Unix distribution of TEX.

• CMacTEX supports Apple Script and several sample scripts illustrate the usefulness
of scripts when working with complex documents or when wanting to automate
repetitive tasks.

• The internal memory parameters used by all variants of TEX, Metafont, and Meta-
post can be changed by the user.

• The dvi previewer supplied with CMacTEX, macdvi, can display certain types of
included eps graphics, has full support for color, and can display the Postscript
versions of the CM and AMS fonts. It has an auto-refresh feature, making it easy to
use with other TeX installations.

• Dvips has been upgraded to version 5.86d and provides better support for partial
downloading of Postscript fonts. The dvips manual is available in pdf format.

• MacGhostView is based on ghostscript 7.04 and can display selected pages of a
Postscript document. It allows the user to view the pages, in arbitrary order, of doc-
uments conforming to Adobe’s Document Structuring Conventions. Macps2pdf is
a postscript conversion utility based on ghostscript 7.04.

• Bibtex implements dynamic, rather than static, data structures. If bibtex runs out
of memory, just increase the memory partition for bibtex in its “Get Info” window.

• All of the search paths used by any CMacTEX program are set with the setpaths
utility. This consolidation simplifies the process of setting search paths. All search
paths are global, so all programs use the same search paths when looking for tfm files,
macros, etc. A new feature of this version of CMacTEX implements file searching
through database searches rather than through disk searches.
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• The Transfer menu in CMacTEX has been consolidated into one menu, accessible
to all of the programs. Items can be added to or deleted from this menu with the
CMacTeX program.

• If you are running OS X and you have installed teTEX with TEXShop, CMacTEX
can use the teTEX texmf tree.

• The complete Unix manual for TEX/MF is available in pdf format. Although this
document, written by K. Berry, is intended for Unix installations, there is plenty of
information in it useful for any TEX installation.

This manual only attempts to explain how CMacTEX works as a TEX installation. It
does not try to explain any of the subtleties of TEX. For this kind of information you
should consult the Unix manual mentioned above or any of the numerous books on TEX.

All of the programs included with CMacTEX share a common interface and this man-
ual will discuss only a few of the programs in detail.
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2 Shareware Registration and Warranty

The shareware registration fee for CMacTEX is US $35 for a single user. A site license
(up to 100 users) is available for US $300. The fee is the same even if you are using only
a part of CMacTEX. A registered user is entitled to free updates and technical support.
When you pay the registration fee, I will send you a password via e-mail that will dismiss
those nagging dialog windows. You can pay the registration fee by credit card through
PayPal (http://www.paypal.com) or use the Register program. I have a contract with Kagi
Shareware, and they will process any registration fees for me. Just launch the Register
program and follow the online instructions. I prefer registrations through PayPal since
their processing fees are much lower than those of Kagi. If you are paying the registration
fee by a check drawn on a US Bank or an international money order, you can send the
payment directly to me and thus avoid the additional delay in receiving your password. If
you send a check to me, make sure that it is payable to me.

Thomas R. Kiffe
P.O. Box 516
College Station, Texas 77841
USA

Be sure to include your e-mail address with your remittance.
Tom Kiffe hereby disclaims all warranties relating to this software, either expressed

or implied, including without limitation any implied warranties of fitness for a particular
purpose. Tom Kiffe will not be liable for any special, incidental, consequential, indirect or
similar damages due to loss of data or any other reason, even if Tom Kiffe or an agent of his
has been advised of the possibility of such damages. In no event shall Tom Kiffe’s liability
for any damages ever exceed the price paid for the license to use the software, regardless of
the form of the claim. The person using the software bears all risk as to the quality and
performance of the software.

Any comments, suggestions, questions, and bug reports may be sent to me via e-mail.
My address is tom@kiffe.com.
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3 Downloading CMacTEX

CMacTEX is available only through the Internet and may be downloaded from any Com-
prehensive TEX Archive Network (CTAN) site or from the CMacTEX Web Page. The
main CTAN sites are ctan.tug.org (U.S.), ftp.tex.ac.uk (U.K.), and ftp.dante.de (Ger-
many). CMacTEX is located in the nonfree/systems/mac/cmactex directory. The official
Web page for CMacTEX is at http://www.kiffe.com/cmactex.html. The latest releases and
any intermediate updates will appear on the CMacTEX Web Page first and then will be
sent to CTAN for general distribution. CMacTEX is distributed as a collection of stuffit
archives that have been converted to MacBinary format. Below is a complete listing of
each archive file and a brief description of its contents.

cmactex.sit.bin This archive contains the texmf-cmt folder, some sample Ap-
ple Scripts, the Register program, and the CMacTEX Prefs
file.

binaries.sit.bin This archive contains the Carbon programs. You must have at
least Mac OS 8.6 and CarbonLib 1.0.4 to run these programs.
They will run in native mode on Mac OS X.

classic-binaries.sit.bin This archive contains the Classic programs. You must have at
least Mac OS 8.1 to run these programs.

texmflib.sit.bin This archive contains most of the macro and font files you
need for a TeX installation.

type1.sit.bin This archive contains the Postscript CM and AMS fonts in
pfb format.

bbedit-plugins.sit.bin This archive contains plug-ins for BBEdit 6.x, allowing the
user to run CMacTeX from this text editor.

macghostview256.sit.bin This archive provides MacGhostView, macps2pdf and all of
the font and library files needed to run ghostscript.

macfonts.sit.bin This archive contains the Postscript CM and AMS fonts as
Macintosh screen and printer fonts. The fonts can be used to
preview dvi files if Adobe Type Manager is installed.

doc.sit.bin This archive provides documentation files, manuals, and test
files for bibtex, dvipdfm, dvips, and pdftex.
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4 Installing CMacTEX

4.1 Full Installation

The installation of CMacTEX is really quite simple. CMacTEX comes with default search
paths and, if you follow the steps below, you should not have to set any paths yourself in
order to get CMacTEX up and running. Later you can set your own search paths after you
have decided how to organize all of the files included in CMacTEX.

1. Unpack cmactex.sit.bin. Move the CMacTeX 4.1 folder to your hard drive and
open it. Move the file CMacTeX Prefs to the Preferences folder of the System folder
on your startup drive.

2. Unpack binaries.sit.bin or classic-binaries.sit.bin and move the binaries folder to the
CMacTeX 4.1 folder. If you don’t have OS X, use the Classic binaries.

3. Unpack texmflib.sit.bin and move the texmf folder to the CMacTeX 4.1 folder.

4. Unpack type1.sit.bin and move the type1 folder to the fonts folder inside the texmf
folder.

5. If you are using BBEdit 6.x or BBEdit Lite 6.x, unpack bbedit-plugins.sit.bin, open
the BBEdit 6.x plug-ins folder and move all of the items to BBEdit’s Plug-ins folder.

6. If you have Abode Type Manager installed and wish to use Postscript fonts for
previewing in macdvi you need to install both screen fonts and Printer fonts in the
Fonts folder of your System Folder. Each font suitcase included in the macfonts
folder comes in two versions, a regular and a “hidden” version. You must install
only one version of each suitcase. If you install the “hidden” screen fonts the fonts
will not appear in the Fonts Menu of any program. Unpack macfonts.sit.bin, open
the folder macfonts and move the desired font suitcases and all of the Postscript
printer fonts to the Fonts folder inside your System folder.

7. Unpack doc.sit.bin. Put the doc folders wherever you wish.

4.2 OS X Installation

If you are running OS X and want to do a full installation the only change to the in-
structions given above is to place the file CMacTeX Prefs in the Preferences folder inside
your User Library folder. If you have installed teTEX and want to use its texmf tree with
CMacTEX, follow the installation instructions on the OS X section of the CMacTEX Home
Page.

4.3 Configuration

Launch the setpaths program and choose Initialize default search paths item under the
File menu. You will have to do this whenever you add any files or folder to the texmf-cmt,
texmf-local or texmf folders. Now choose Use databases for file searches under the File
menu.
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The behavior of dvips is controlled through the config.ps file located in the texmf-
cmt/dvips/config folder while pdftex is controlled through the pdftex.cfg file in the texmf-
cmt/pdftex/config folder. These files can be opened with the Open config file item under
the Edit Menu in CMacTEX. Dvips and pdftex are are configured for “letter” size paper.
To make any other paper size your default you must edit config.ps and pdftex.cfg.

In order to have either program embed Postscript fonts in your document you must
specify which fonts are available as Postscript fonts on your computer. The various .map
files include in the texmf-cmt/dvips/config folder map the tfm name of a font to the name
of the Postscript font which will be used to supply the glyphs of the font. Dvips reads only
the .map files specified in config.ps, pdftex does the same with pdftex.cfg. Included in the
texmf-cmt/dvips/config folder are the map files for the Computer Modern, AMS, xypic,
Lucida, MathTime, and common Adobe Postscript fonts. Only the Computer Modern,
AMS, and xypic Postscript fonts are freely available and are included with the distribution.
Every reasonable TeX installation contains the support files (tfm, vf, fd, sty) to use the
Lucida, MathTime, and common Adobe fonts but not the actual Postscript fonts. You
must purchase the Lucida and MathTime fonts from YandY. You can purchase the Adobe
Postscript fonts or you can use the urw clones of these fonts. The urw clones are included
with teTEX and can be downloaded from CTAN. On most computer systems Postscript
fonts are distributed in pfb format. On a Macintosh Postscript fonts are distributed in a
format that is unreadable on any other computer system. These fonts are sometimes called
Macintosh printer fonts and their file type is ’LWFN’. They are equivalent to pfb fonts
but the Postscript code is included in the resource fork of the file rather than the data fork.
Further complicating the issue is the fact that a given font has a different file name if it is
in lwfn or pfb format or if it is a urw font. I will call Macintosh printer fonts lwfn fonts.
Since dvips and pdftex were not created on a Macintosh they can’t read lwfn fonts. I have
made changes to both dvips and pdftex to allow them to handle lwfn fonts.

Once you has assembled whatever Postscript fonts you want in whatever format you
have you must configure dvips and pdftex to use the fonts you actually have. Dvips always
reads the file called psfonts.map. This file contains the mappings for the 14 standard
Postscript fonts. These are the Symbol font, ZapfDingbats, and four variants each of
Courier, Helvetica, and Times. These fonts do not have to be embedded in Postscript
and PDF files and my psfonts.map does not embed them. I have provided three variants
of this file, one for lwfn fonts, one for pfb fonts, and one for urw fonts. If you have
these 14 standard fonts in one of these forms and want to embed them in your files,
change the name of one of psfonts-lwfn.map, psfonts-pfb.map, or psfonts-urw.map to
psfonts.map. To configure dvips to use other Postscript fonts, open config.ps and go the
section of that file which lists which .map files dvips will read. By default dvips will use
lwfn fonts for common Adobe fonts, Lucida fonts, and MathTimes fonts. It uses pfb fonts
for the Computer Modern, AMS, and xypic fonts. Change the names of the files to reflect
the actual fonts you have installed. For instance, if you have the urw equivalents of the
common Adobe fonts, change the entry adobe-lwfn.map to adobe-urw.map.

Configuring pdftex is similar to configuring dvips. The only difference is that pdftex
does not read a default .map file. It only reads the .map files specified in pdftex.cfg. The
pdftex.map file handles the standard 14 Postscript fonts. If you have these fonts in either
pfb or urw format you should have pdftex read either pdftex-pfb.map or pdftex-urw.map.
If you have these fonts in lwfn format or don’t have them at all, have pdftex read pdftex-
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lwfn.map. Pdftex does not embed the standard 14 fonts unless it tell it to do so from the
pdftex options item under the Options Menu in the CMacTeX program. If you don’t
have the fonts never tell pdftex to embed them.

The last program to configure relative to fonts is macdvi. If you are running CMacTEX
in OS X you can only use bitmap fonts for previewing since Adobe Type Manager is not
available. If you have the Metafont sources for a particular font, macdvi will call maketexpk
to generate the corresponding bitmap font. If you don’t have the Metafont sources macdvi
will use a Macintosh screen font for display. If you use Adobe Postscript fonts in your
document you should convert the dvi file to Postscript with dvips and view the resulting
Postscript file with MacGhostView.

If you are using OS 8 or 9 and have installed Adobe Type Manager you can preview
with Postscript fonts as long as these fonts are in lwfn format and you have the correspond-
ing screen fonts. Read the preview.cfg file in the texmf-cmt/macdvi/config folder to see
what you must do for this to work.
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5 SetPaths and File Searching

A typical TEX installation consists of thousands of support files distributed over hundreds
of folders. The programs in a TEX distribution must be able to find these files efficiently.
CMacTEX organizes its support files in accordance with the TEX Directory Structure im-
plemented in most TEX installations. The support files common to any TEX installation
are contained in a texmf folder. Inside this folder the files are organized by type. Generic
files supplied by the user are organized in a similar fashion inside a folder called texmf-local
or texmf-user. Files specific to CMacTEX are organized inside a folder called texmf-cmt.

The folders, if they exist, must have these names and they must be located in the same
folder as the binaries folder. If you wish to keep a texmf tree outside of the binaries folder,
make an alias to the folder and put the alias inside the binaries folder. The name of the
alias must be one of texmf-cmt, texmf-user, texmf-local, or texmf. CMacTEX first searches
the texmf-cmt folder, then the texmf-user folder, then the texmf-local folder, and finally
the texmf folder.

The sole function of the setpaths utility is to set the search paths used by CMacTEX.
The default search paths built into CMacTEX will work only if you have followed the
installation instructions exactly so that all of the programs are in the binaries folder and all
support files are in folders or aliases named texmf, texmf-local, texmf-user, and texmf-cmt.
Setpaths resolves all aliases when it initializes search paths so you can use aliases to refer
to particular folders located outside the texmf folders. If you want CMacTEX to search
your Fonts folder for Postscript fonts, make an alias of the Fonts folder inside your System
Folder and move the alias to the texmf-cmt:fonts:type1 folder.

You must initialize search paths whenever you add new files or folders to any of the
texmf folders. The expanded search paths are stored in the CMacTEX preferences file,
CMacTeX Prefs, which is in your Preferences folder. If this file is not present or it is
corrupted, CMacTEX will not be able to find any support files. I recommend that you
periodically make a copy of CMacTeX Prefs and store it in a safe place. If CMacTeX Prefs
becomes corrupted you will have a current replacement file and will not have to configure
CMacTEX from scratch.

The characters /, %, and ‘nonbreaking space’ (option-space on a Macintosh, ascii code
202) are special and may not be used in file and folder names. CMacTEX uses Unix
style path names internally and / is the Unix directory separator. If you are transferring,
from a Unix platform, a complex document that contains Unix paths, CMacTEX will
translate those paths automatically into Macintosh paths. Some TEX programs do not
work correctly if a file or folder name contains a space character. Since a space character
in a file or folder name is quite common on a Macintosh, CMacTEX internally converts
a space character to a nonbreaking space and vice versa. The % symbol is used to specify
special search paths for pk files. Make sure that no files or folders in your TEX tree have
names containing a /, %, or ‘nonbreaking space’ before you run setpaths.

5.1 Search Variables

Here is a brief summary of the search variables used by CMacTEX. More detailed infor-
mation on how a particular program uses a search path is included with that program.
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TEXINPUTS tex, etex, pdftex, and pdfetex search these folders for tex macro
files and cfg files.

TEXFORMATS tex, etex, pdftex, and pdfetex search these folders for format
(.fmt) files, pool files, and cnf files.

TEXPOOL tex, etex, pdftex, and pdfetex search these folders for pool files.

TEXFONTS tex, pdftex, dvips, macdvi, metapost, and dvipdfm search these
folders for tex font metric (.tfm) files.

PKFONTS dvips, macdvi, dvipdfm, and pdftex search these folders for pk
font files.

VFFONTS dvips, dvicopy, macdvi, dvipdfm, and pdftex search these fold-
ers for virtual font files.

AFMFONTS afm2tfm searches these folders for afm files.

MFINPUTS metafont and metapost look here for macro (.mf) files

MFBASES metafont searches for base (.base) files and cnf files in these fold-
ers.

MFPOOL metafont searches for pool files in these folders.

TEXCONFIG dvips looks here for config and mapping files.

DVIPSHEADERS these folders contain the header files and encoding files used by
dvips, dvipdfm, and pdftex. Dvipdfm looks here for its config
and mapping files.

TYPE1FONTS dvips, dvipdfm, and pdftex search these folders for Postscript
fonts.

DVIPSEPSF dvips searches these folders for epsf files.

ENCODINGS macdvi uses these folders to search for Postscript encoding files
and preview mapping files.

BIBINPUTS bibtex searches for .bib files in these folders. Bibtex8 also looks
here for csf files.

BSTINPUTS bibtex searches for .bst files in these folders.

ISTINPUTS makeindex searches for .ist files in these folders.

MPINPUTS metapost looks in these folders for macro (.mp) files.

MPMEMS metapost searches these folders for mem (.mem) and cnf files.

MPPOOL metapost looks here for pool files.

MTPKTMPFOLDER maketexpk puts the pk files it generates in this folder.

The default folders that are used by these variables are listed in the file default.paths. If
you are not using a TDS tree structure you can use this file as a template for creating your
own search paths.

5.2 Initializing Search Paths

Under the File menu setpaths has two commands for initializing search paths. To set the
default search paths select Initialize default search paths. If you have created your own
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default.paths file you can use it to set search paths by selecting Initialize search paths
from file. Setpaths will expand all search paths, resolve any alias folders, and write the
database files.

5.3 Database File Searches

CMacTEX can be configured to search databases for macro and font files rather than search-
ing your hard drive. Database searching is considerably faster than disk searching, espe-
cially if a large number of files have to be found. The databases are used by tex, pdftex,
macdvi, and dvips. The databases are created whenever you initialize search paths and
they are placed in the CMacTeXDataBases folder inside your Preferences folder. Database
searching can be turned on and off with the Use databases for file searches item under
the File menu.

5.4 Search Paths and OS X

If you are running OS X and have teTEX already installed you can use the texmf tree from
teTEX with CMacTEX. Instead of using the texmf tree provided with CMacTEX you can
use a symbolic link from the teTEX texmf folder. See the installation instructions in the
OS X section of the CMacTEX Home Page.

5.5 Search Paths for pk Files

Dvips, macdvi, and pdftex can generate missing pk files from appropriate metafont sources
by calling maketexpk. The default configuration for CMacTEX organizes pk files by meta-
font mode and dpi. It may be necessary for maketexpk to create new folders when gener-
ating pk files and these folders must be searched when programs are looking for pk files.
Since setpaths can handle only existing folders when it initializes search paths, a method
has to created for handling new pk files and folders . This is done by creating a special
folder inside the pk folder called %m/%d/%f.%dpk. Dvips, macdvi, and pdftex can use
this variable search path when looking for pk files and maketexpk uses it when creating pk
files. The general rule is that if a % character is found in a path, the following substitu-
tions will be made, and then a search will be made for the resulting file. %f is replaced by
the font name, %d is replaced by the font size in dots per inch, and %m is replaced by the
Metafont mode. Note that, if a folder name contains a percent sign, the folder name must
give the full file name, including the path from the pk folder, rather than just the folder
name. If you just named this empty folder %d instead of %m/%d/%f.%dpk, dvips, macdvi,
and pdftex will try to open .../pk/329 when looking for cmr10.329pk, for instance, and
this is not what is intended. The name of the special empty folder must expand to a file
name after the substitutions are made. Do not put any pk files inside the folder named
%m/%d/%f.%dpk; this folder is not searched for pk files.
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6 TEX

CMacTeX is the command center when typesetting a document and is probably the only
program you will launch from the Finder. From CMacTeX you can issue commands to
typeset your document with either tex or pdftex, launch the dvi previewer, convert the dvi
file to Postscript, launch the Postscript viewer, convert Postscript to PDF, launch the PDF
viewer, make indices and bibliographies, and build format files for tex and pdftex. You can
run dvipdfm, mpost, dviutils, and psutils from CMacTeX.

The tex and pdftex programs have no useful interface. They are designed to be called
by CMacTeX for typesetting a document. There is no reason to launch tex or pdftex
directly or to send any Apple Events to them.

When it is launched, tex reads the configuration file tex.cnf and pdftex reads pdf-
tex.cnf. These files have settings for various memory parameters used by tex and pdftex.
They search for tex.cnf and pdftex.cnf in the folders specified by the TEXFORMATS
variable. If these files is not found, tex and pdftex will use built-in values for their memory
parameters. If tex or pdftex prints any error messages about its memory capacity being
exceeded, you may want to increase some of the values set in either tex.cnf or pdftex.cnf.
Changing these parameters may require you to rebuild your format files. TeX and pdf-
tex use Temporary Memory for these data structures so you do not have to increase the
memory partition given to tex or pdftex by the Finder.

6.1 Menu Commands

6.1.1 File Menu

Typeset Choose a file to be typeset.

Typeset xxx Typeset the last file processed, provided that file still exists
in its original location.

Typeset recent Select a file for typesetting from a list of recently opened
files.

Repeat last TeX command Redo the last command executed by any TeX program.

Build format This command can be used to build format files. You can
modify the command line and use the “Set Directory”
button to make sure that format files are placed in the
correct folder.

bibtex xxx.aux Run bibtex on the aux file created by tex.

View xxx.dvi View the indicated dvi file.

dvips xxx.dvi Convert the dvi file to Postscript by calling dvips.

View xxx.ps Call a previewer to display the indicated Postscript file.

Ps2pdf xxx.ps Convert the indicated Postscript file to PDF by calling
macps2pdf, Distiller, or any other converter which re-
sponds to an “Open doc” event.

View xxx.pdf Call a PDF viewer to display the indicated PDF file.

Save Save the output written to the console in a file.

11



Quit Quit the application.

6.1.2 Edit Menu

Clear Clear the console window.

Console font Set the font to be used to display text in the console win-
dow.

Font size Set the size of the font to be used to display text in the
console window.

8-bit output Use 8-bit characters in the console window and in .log
files.

Info View information about the selected program.

Open config file Ask your text editor to open the selected configuration
file.

6.1.3 Options Menu

TeX program Choose a tex program to be run when the Typeset item
is selected or when CMacTeX receives an ”Open Docu-
ment” Apple Event.

TeX format Choose the format to be used by tex, etex, pdftex or pdef-
tex.

Add \src specials When this item is checked tex adds \src specials to a dvi
file. Macdvi uses these specials to link the dvi file to the
tex source files.

pdftex options Set some options when running pdftex or pdfetex.

Auto switch to previewer This item tells CMacTeX to launch the dvi or pdf pre-
viewer automatically after it is finished processing a file.

Debug paths If this item is checked, tex and pdftex will print the full
names of all the files they are trying to open. This feature
is useful if tex reports that it cannot find a file or you are
trying to debug your installation.

Set search paths This item launches setpaths, from which the user can set
or change the search paths used by tex.

Set apps This item allows you to set some of the programs that
can be launched from CMacTeX.

Set utilities This item allows you to set some of the utilities that can
be launched from CMacTeX.

bibtex options Set options for running bibtex.

dvips options Set options for running dvips.

mpost options Set options for running mpost.

psutils options Set options for running psutils.
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The Apps and Utilities Menus can be used to run selected programs from CMacTeX.
When any item under these Menus is selected, a dialog window appears in which you
specify input and output files for the selected program. The Transfer Menu simply allows
the user to launch some other program.

Tex and pdftex require that a number of paths be set correctly in order for them to
work at all. The paths used by tex and pdftex include TEXFONTS, TEXINPUTS, TEX-
FORMATS, and TEXPOOL. TEXFONTS is the list of folders in which tex and pdftex
will look for tfm files. TEXINPUTS is the list of folders in which they will look for macro
(.tex) and style files. TEXFORMATS is the list of folders in which they will look for
format(.fmt) files. TEXPOOL is the list of folders in which they will look for pool files.
Pdftex will look in the folders specified by the DVIPSHEADERS and TYPE1FONTS
paths for Postscript mapping, encoding, and font files. All of these paths are set with the
setpaths utility.

A convenient file included in the texinputs folder is null.tex, containing nothing.
When tex can’t find a file it thinks you want to input, it will keep asking you for another
filename; responding ‘null’ gets you out of the loop if you don’t want to input anything.

6.2 e-TEX

This is an extension of TEX which may be of interest to some users. The CMacETeX
program differs from CMacTeX in that it uses etex and pdfetex to typeset a document.
The e-TEX manual is included in the doc folder.

6.3 pdfTEX

This is an extension of TEX which can create PDF files as well as create regular dvi files
directly from tex sources. The CMacTEX Web Page contains links to useful information
about pdfTEX. The behavior of pdftex is determined by options specified in the pdftex.cfg
file and by options set with the pdftex options item under the Options Menu.
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7 Metafont

Metafont reads the program in the specified files and outputs font rasters (in gf format)
and font metrics (in tfm format). The Metafont language is described in The Metafont
Book.

Like TEX, Metafont is normally used with a large body of precompiled macros, and
font generation in particular requires the support of numerous macro files. To run Meta-
font, launch mf, choose Execute from the File Menu. Set the directory to any folder you
wish and, in the command line dialog box, type

mf \mode=<printengine>; [mag=magstep(n);] input font

to start processing font.mf.
Inimf is the program that builds precompiled base files (.base) for mf. Before building

a base file you need to examine the file modes.mf in the mfinputs folder. This file contains
the specific information mf needs to build fonts for a particular print engine. Check the
variable localfont in modes.mf and make sure it is set to the type of print engine you
use most often. If you regularly print on a 300 dpi LaserWriter, you will want to set
localfont to CanonCX. This variable represents the default mode of mf; unless a different
mode is specified when running mf, mf will build fonts with the characteristics specified
by localfont.

To build a base file, launch mf and select Execute from the File Menu. Set the directory
to your mfbases folder and, in the command line dialog box, type

mf -ini -base=mf plain \input modes \dump
Inimf will create a file called mf.base in the mfbases folder. Base files can also be built with
the Build base command or with an AppleScript.

When it is launched, mf can read the configuration file mf.cnf, which has alternate
settings for various memory parameters. It will search for mf.cnf in the folders specified
by the MFBASES variable. If this file is not found, mf will use built-in values for these
parameters. If mf prints any error messages about its memory capacity being exceeded, you
may want to increase some of the values set in mf.cnf. Changing these parameters may
require you to rebuild your base files. Metafont uses Temporary Memory for these data
structures so increasing the memory partition given to mf by the Finder will not increase
mf ’s capacity.

7.1 Menu Commands

7.1.1 File Menu

Execute Launch mf.

Build base Build the “plain” base file for Metafont.

Interrupt Interrupt the current Metafont run.

Save Save the output written to the console in a file.

Quit Quit the application.

7.1.2 Edit Menu

Clear Clear the console window.
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7.1.3 Options Menu

Debug paths If this item is checked, Metafont will print the full names
of all the files it is trying to open. This feature is useful
if Metafont reports that it cannot find a file or you are
trying to debug your installation.

Set search paths This item launches setpaths, from which the user can set
or change the search paths used by Metafont.

Set view window This item allows the user to set the location and size of
Metafont’s viewing window. This window only appears
if you are designing fonts instead of merely generating gf
and tfm files for an existing font.

A convenient file in the mfinputs folder is null.mf, which contains nothing. When mf
can’t find the file it thinks you want to input, it keeps asking you for another file name;
responding ‘null’ gets you out of the loop if you don’t want to input anything.

Metafont requires that a number of paths be set correctly in order for it to work at all.
The paths used by Metafont include MFINPUTS, MFBASES, and MFPOOL. MFIN-
PUTS is the list of folders in which Metafont will look for macro (.mf) files. MFBASES
is the list of folders in which Metafont will look for base(.base) files. MFPOOL is the list
of folders in which Metafont will look for pool files. These paths are set with the setpaths
utility.
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8 Dvips

Dvips is the program that converts dvi files to Postscript files. It supports hyperpostscript
and the partial downloading of Postscript fonts in either pfa, pfb or LWFN (Macintosh
Postscript font) format. If you use Postscript fonts in any format, be sure to read config.ps
carefully and modify it appropriately so that dvips reads the correct Postscript mapping
files. Dvips is designed to be called by the CMacTeX program, just like tex and pdftex.
Unlike tex and pdftex it can be run by itself but it can convert only one file before it must
be restarted. For this reason it is easiest to run dvips from CMacTeX.

8.1 Menu Commands

8.1.1 File Menu

Dvi File Select a dvi file to convert to Postscript.

Output file Set the name of the output file rather than use the de-
fault.

Run Begin processing the dvi file.

Convert ??? Convert the indicated dvi file, if it still exists in its origi-
nal location.

View After a Postscript file has been created, use this command
to open a Postscript viewer to display the file.

Convert to pdf After a Postscript file has been created, use this command
to send the file to a ps to pdf converter. You must have
macps2pdf or Adobe Distiller installed.

Save Save console output in a file.

Quit Exit dvips.

8.1.2 Options Menu

Set options When this item is selected, dvips opens a dialog window
listing all of the options recognized by dvips.

Set search paths This option launches the setpaths, the utility which is
used to set the search paths used by dvips.

Set creator for ps files This option sets the application which will be opened
when the user double-clicks on a ps file created by dvips.

Auto quit on switch When this item is checked dvips will quit automatically
after it has converted a dvi file. Dvips quits when it
is switched to the background. This feature is useful if
you are running dvips by itself rather than calling it from
CMacTeX. It doesn’t quit until it is switched to the back-
ground to give you an opportunity to read any error mes-
sages on the console window before it quits.
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8.2 Automatic Font Generation

In order to generate the correct pk files dvips needs to know the resolution of your printer
and the metafont mode for your printer. These values are entered in config.ps, the main
configuration file for dvips. The default resolution is 300 and the default metafont mode
is CanonCX. These values are appropriate for the older LaserWriters from Apple. If you
using a LaserWriter Select 360, for example, you would set the resolution to 600 and
the metafont mode to CanonEX. Config.ps should contain the settings for your default
printer. If you regularly use more than one printer, you should create printer-specific
configuration files rather than change the values in config.ps. As an example, suppose that
you occasionally print on a NeXT printer. Duplicate config.ps and rename it config.next.
Open config.next and change the resolution to 400 and the metafont mode to nexthi.
When you run dvips, use the Options Menu to load in the config.next file.

The available metafont modes are listed in modes.mf, which should be located in your
mfinputs folder. If you ever have to build the metafont base file with inimf, be sure to
include modes.mf.

Dvips calls maketexpk to generate the missing pk files. You should set the options for
maketexpk before running dvips.
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9 Macdvi

Macdvi is the program for previewing dvi files. It automatically resolves virtual fonts and
provides full support for color. Even if a dvi file contains no color commands you can
still set foreground and background colors for easier viewing. Since macdvi draws an
entire page in an offscreen bitmap before showing the page on a computer screen, colored
text on a colored background is drawn correctly. Macdvi uses temporary system memory
for its offscreen drawing environment. If it reports that it can’t find enough memory
for an offscreen bitmap you will have to quit some open applications or turn on virtual
memory. Increasing the memory partition for macdvi will not solve the problem. Macdvi
automatically redisplays an open dvi file if that file has been modified by another program.
The redisplay occurs when macdvi is brought to the front.

If tex is run with the “Add \src specials” option, then the dvi file contains information
linking it to the tex source files. If you option-click in a paragraph in a displayed page
macdvi will tell print the line number and the name of the source file corresponding to the
mouse click. If you are using either Alpha or BBEdit macdvi will ask your editor to open
the source file and highlight the line.

It can’t display any Postscript code included in a dvi file with a \special{} or with a
package like pstricks. Macdvi is a dvi previewer, not a Postscript previewer. It can display
some included encapsulated Postscript files if the eps files have a PICT 256 resource and
the images are not rotated or clipped. The best way to view a tex document contain-
ing Postscript fonts or graphics is to convert the dvi file to Postscript and then view the
Postscript file with MacGhostView.

Macdvi can display Postscript fonts if you have the bitmap screen fonts and the printer
fonts installed in the Fonts folder inside your System folder and you have installed Adobe
Type Manager 4.0.2 (4.5.2 for OS9) or later. The Computer Modern and AMS fonts are
freely available as Postscript fonts and you can use the Postscript versions of the fonts for
previewing. If you use the Postscript fonts you will not have to generate a large collection
of pk fonts in various sizes for previewing dvi files. Since macdvi looks for pk fonts by
default and uses maketexpk to generate them from metafont sources if they are not found,
macdvi has to be explicitly told to use the Postscript fonts instead. A dvi file only contains
the names of the tfm fonts used in the file and macdvi must read an auxiliary file which
maps the tfm font names to bitmap screen fonts. The file preview.cmfonts contains the
mappings for Postscript CM and AMS fonts. It is located in the macdvi folder inside your
texmf folder. The macdvi folder also contains mapping files for use with other families
of Postscript fonts. When it is launched, macdvi reads preview.cfg. This file tells macdvi
which Postscript–to–screen mapping files to read. You should read this file carefully in
order to see how to add or delete mapping files.

If you use standard Postscript fonts (Courier, Helvetica, Times, etc) in your tex doc-
uments, you can map those fonts to corresponding TrueType fonts for previewing. The
mappings for the standard Postscript fonts are recorded in preview.psfonts. Since Postscript
fonts usually have a different encoding than Macintosh fonts, macdvi must also read vari-
ous encoding files. These encoding files are included in the macdvi folder.
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9.1 Menu Commands

9.1.1 File Menu

Open Select a dvi file to preview.

Open xxx.dvi Preview the current dvi file, xxx.dvi. This is the last dvi
file created by any application. The item will be disabled
if the current dvi file has been moved or deleted.

Open Recent Select a file for previewing from a list of recently opened
files.

Close dvi file Close the currently open dvi file.

Convert to Postscript Call dvips to convert the current dvi file to Postscript.

Save Save the currently displayed dvi page as a PICT file or
save the console output in a file.

9.1.2 Edit Menu

Copy Place the currently displayed dvi page as a PICT resource
on the Clipboard.

Clear Clear the console window.

Info Display a help file in the console window.

Open preview.cfg Ask your text editor to open macdvi’s principal configu-
ration file.

9.1.3 View Menu

First Page View the first physical page of the document.

Previous page View the previous page, if there is one.

Next page View the next page, if there is one.

Last Page View the last physical page.

Go to page Select a page for previewing.

Go to last viewed page This item tells macdvi to display the page having the
same physical page number as the last page viewed in the
last dvi file. It helps you return to a specific page after
you have made changes to a tex file.

Redraw current page If the display of the current page is not correct, selecting
this item will redraw the page.

Zoom in Increase the magnification of the current page.

Zoom out Decrease the magnification of the current page.

Zoom back View document at previous magnification.

Fit in view Resize the current page so that it fits completely inside
the previewing window.

Maximum size Show the current page at maximum magnification.
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View page as Postscript Convert the displayed page into Postscript and open the
Postscript previewer.

Console Window Bring the console window to the front.

Display Window Bring the display window to the front.

9.1.4 Page Menu

This menu is just a list of the pages in the current dvi file. Selecting one of them displays
that page. Only the first 100 pages are listed under this Menu.

9.1.5 Options Menu

Display Page Geometry Set page size, orientation, and resolution for previewing.
The default resolution for previewing with macdvi is 300
dpi. The value you set here determines the size of the pk
fonts macdvi will use to display the document. If you are
printing on a 300 dpi Postscript printer, macdvi will use
the same pk files for previewing as dvips would use for
printing. You may use whatever resolution you wish for
previewing and macdvi can be set to automatically gener-
ate any pk files it needs if you have installed CMacTEX’s
metafont package. The user can set the color depth used
by macdvi when it displays a page. Macdvi can display
color commands in the dvi file. These commands must
follow the syntax for color commands used by dvips. The
files colordvi.tex and colordvi.sty, supplied with dvips,
explain how to include color commands in your TEX
file so that they cab be used by dvips and macdvi. Any
changes take effect the next time a dvi file is opened. If
automatic pk font generation is turned on, macdvi must
tell metafont which mode to use. This mode must be
consistent with the dpi setting or metafont and gftopk
will not create the correct pk file. If your resolution is
set at 300 dpi, you should set the metafont mode to
CanonCX or cx. See the file modes.mf, supplied with
metafont, for a description of all standard modes and
their corresponding resolutions.

Color preferences With this item the user can set the foreground and back-
ground colors macdvi will use to display a page. Color
commands included in the dvi file will overwrite these
settings.

Screen font If macdvi can’t find a pk font of the correct size and you
are not generating pk fonts, it will try to display the font
characters using a Macintosh screen font. The default
screen font is Geneva and the resulting display is truly
awful.
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Make fonts If you have installed the metafont package, macdvi can
automatically generate any pk files it needs for preview-
ing. If you don’t want to wait for macdvi to generate
fonts, turn this option off and macdvi will record the
missing fonts in a file called missviewfont.log. You can
generate the fonts later with maketexpk.

Debug When this option is turned on, macdvi will print the
name of every file it is trying to open. This is useful
when you are debugging your search paths.

Debug \special When this option is turned on, macdvi will print all
\special commands to the console window and any eps
graphics are enclosed in a box.

Dithering If dithering is turned on, macdvi will render the dis-
played page in gray scale rather than black and white.
This improves the display quality when the file is viewed
at different magnifications.

Set search paths This option launches setpaths, from which the user can
set the folders macdvi will search when looking for tfm,
pk, and encoding files.

Set dvi to ps converter Use this option to select either CMacTeX or dvips for
converting dvi files to Postscript.

Key mappings This item allows you to change the keys used to move
around a displayed page of your dvi file.

Slow scrolling Use this option only if you insist on covering part of
macdvi’s display window with one or more floating win-
dows.

9.2 Key Mappings

Pressing various keys while the display window is in front moves you around the page and
the document as follows.

n Go to the next page.

p Go to the previous page.

f Go to the first page.

l Go to the last page.

g Call the Goto Page Dialog Box.

h Center the page horizontally.

v Center the page vertically.

i Zoom in (increase magnification).

o Zoom out (decrease magnification.

u Scroll upward one screen. If at the top of a page, scroll to the bottom of
the previous page.
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d Scroll downward one screen. If at the bottom of a page, scroll to the top
of the next page.

The four arrow keys also move you around a page in small increments. The “page up” and
“page down” keys work just like the ‘u’ and ‘d’ keys respectively. The “home” key takes
you to the upper left-hand corner of a page while the “end” key takes you to the lower
right-hand corner.
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10 MacGhostView and macps2pdf

MacGhostView is a Postscript viewer, based on ghostscript 7.04, which allows the user
to view the pages of a Postscript document in any order if the document conforms to
Adobe’s Document Structuring Conventions (DSC). It has the same basic structure as
macdvi, drawing a complete page in an offscreen bitmap before displaying it on a computer
screen. TeX documents containing Postscript code, images, or fonts are best previewed
with MacGhostView due to the inherent limitations of dvi previewers. It automatically
redisplays an open Postscript file if that file has been modified by another program. The
redisplay occurs when MacGhostView is brought to the front. MacGhostView can add a
pict preview to an Encapsulated Postscript file.

Macps2pdf is designed as a utility for converting Postscript files to various formats. It
is based on ghostscript 7.04 and the default conversion is from Postscript to PDF. It can
easily convert a 1-page Postscript file into Encapsulated Postscript. For other conversions
macps2pdf should be called from an Apple script since the arguments to the ghostscript
interpreter are too involved to be either remembered or easily typed. I have provided a
sample script, ps2ascii, to show you how to call macps2pdf from a script. Save this script
as an application and drop a Postscript file on it.

10.1 Menu Commands

10.1.1 File Menu

Open Select a Postscript file to view.

Open Recent Select a file for previewing from a list of recently opened
files.

Close Close the display window.

Save Save the displayed page as a PICT file or save the console
output in a file.

Convert to PDF Call macps2pdf to convert the open Postscript file to
PDF.

Interrupt Cancel viewing of a non-DSC file.

Run Open a file for previewing, reporting any errors encoun-
tered while interpreting the pages. This item for opening
a file is the only one that can report any errors. Use it if
the View command fails to display the document.

Quit Quit MacGhostView.

10.1.2 Edit Menu

Copy Place the displayed page as a PICT resource on the Clip-
board.

Add PICT preview Place a pict preview in the resource fork of an opened eps
file.
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Extract pages Create a new Postscript file containing just the selected
pages. This feature only works with DSC Postscript files.

10.1.3 View Menu

First Page View the first page of the document.

Previous Page View the previous page.

Next Page View the next page.

Last Page View the last page of the document.

Go to Page Select a page for viewing.

Zoom In Increase magnification.

Zoom Out Decrease magnification.

Zoom Back Return to previous magnification.

Console Window Bring the console window to the front.

Display Window Bring the display window to the front.

Redraw Display Window Due to rounding errors, the displayed page may become
distorted while scrolling and this item allows you to re-
draw the page.

10.1.4 Options Menu

Display Page Geometry Select the page size, dpi and color depth for the displayed
page.

Debug Paths Print the full pathnames of all files ghostview is trying to
open.

Dither Use grayscale imaging when viewing a document at low
magnifications.

Ignore DSC Comments If a Postscript file does not preview correctly with the
View command, check this item and view the file again.
This option may be necessary for some complex files
which contain comments but are not DSC compliant.
The pages can only be viewed in strict linear order.

Set Search Paths When you select this item you will be ask to locate the
ghostscript folder. By doing so you will be able to move
MacGhostView to any location on your hard drive and
it will be able to find its font and library files.

Key Mappings This item allows you to change the key values for moving
around in the Display window.

Slow scrolling Use this option only if you insist on covering part of
ghostview’s display window with one or more floating
windows.
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10.1.5 Page Menu

When viewing a DSC Postscript file this menu will contain a list of the pages of the
document. Selecting an item will display that page number.

10.2 Key Mappings

Pressing various keys while the display window is in front moves you around the page and
the document as follows.

n Go to the next page.

p Go to the previous page.

f Go to the first page.

l Go to the last page.

g Call the Goto Page Dialog Box.

h Center the page horizontally.

v Center the page vertically.

i Zoom in (increase magnification).

o Zoom out (decrease magnification.

u Scroll upward one screen.

d Scroll downward one screen.

The keys which change pages are activated only if the Postscript document conforms to
Adobe’s Document Structuring Conventions. The four arrow keys also move you around
a page in small increments. The “page up” and “page down” keys work just like the ‘u’ and
‘d’ keys respectively. The “home” key takes you to the upper left-hand corner of a page
while the “end” key takes you to the lower right-hand corner.
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11 Other Programs

Bibtex, metapost, makeindex, all of the tex utilities and all of the Postscript utilities share
the same interface described above. These programs are basically file converters. You
choose an input file and an output file and then run the program. Each of the programs
has on-line help with the Info item under the Help Menu.

11.1 Bibtex, MetaPost, and MakeIndex

Bibtex, metapost, and makeindex are described in the standard books concerned with TEX.
Like dvips makeindex, mpost, and bibtex should be called from the CMacTeX program..

11.2 Dvipdfm

This program can convert certain dvi files directly in PDF. Like dvips and pdftex it should
be called from the CMacTeX program. Unlike dvips and pdftex it can handle Postscript
fonts only in pfa or pfb format.

11.3 TEX Utilities

The only TEX utility most users will ever need is gftopk. It is used to convert gf files created
by metafont into pk files that can be read by dvi previewers and dvips.

11.4 Postscript Utilities

The Postscript utilities provided with CMacTEX are useful for rearranging the pages of
DSC Postscript documents when creating booklets or extracting specific pages of a doc-
ument. The type1 font utilities are useful when converting Postscript fonts between pfa,
pfb, and Macintosh format. To convert a number of files you should use one of the Apple
Scripts provided with CMacTEX.

11.5 Dvi Utilities

These utilities are similar to the Postscript utilities described above. They work with dvi
files rather than Postscript files.

11.6 MakeTeXPK

Maketexpk is a CMacTeX utility for generating a collection of tfm and pk files. It is
called by macdvi, pdftex, and dvips when automatic font generation is activated. If auto-
matic font generation is not activated, these programs generate a file called missfont.log
or missviewfont.log which contains a list of commands for making any missing pk fonts.
Later maketexpk can be run on this file and it generates the missing fonts. The pk fonts will
be placed in a folder set with the Options Menu in maketexpk. If the destination folder
cannot be found, the tfm and pk files are placed in the folder containing the missfont.log
file.
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If you have a list of fonts to make, you can manually run metafont and gftopk on each
font. An alternative is to put a list of the fonts and their magnifications in a file and run
maketexpk on that file. Each line in the file should consist of a font name, a design size, a
base size, and an optional metafont mode. A typical line would be

cmr10 360 300 CanonCX

which would produce cmr10.360pk. If no metafont mode is given, the value of localfont,
as defined in modes.mf when the metafont base file was created, will be used. The mode
set by localfont can be overwritten by setting the metafont mode with the Options Menu.
Of course, the Metafont mode must match the base size. To produce a family of pk files
you could have the following lines in your file:

cmr10 300 300 CanonCX
cmr10 329 300 CanonCX
cmr10 360 300 CanonCX
cmr10 432 300 CanonCX
cmr10 518 300 CanonCX
cmr10 622 300 CanonCX

or just

cmr10 300 300
cmr10 329 300
cmr10 360 300
cmr10 432 300
cmr10 518 300
cmr10 622 300

if CanonCX is your localfont setting or if CanonCX was set with the Options Menu.
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12 Postscript Fonts

CMacTEX fully supports the use of Postscript fonts in TEX as well as using the Postscript
versions of the Computer Modern and AMS fonts. All of the tfm, vf, fd, sty, etc, files
needed to use the “standard” Postscript fonts, the MathTime fonts, and the Lucida Bright
fonts are included in the distribution. The actual Postscript fonts are usually commercial
items and must be purchased from their vendors. Typical Postscript fonts include Times,
Courier, Helvetica, AvantGarde, Garamond, etc. On the Macintosh Postscript fonts are
available in three formats: Macintosh printer fonts, pfb format, and pfa format. CMacTEX
can use any of these formats. The Computer Modern and AMS fonts are available in both
bitmap and Postscript versions and will be discussed below.

12.1 Including Postscript Fonts

Instructions for preparing a TEX document to use Postscript fonts are included in every
modern TEX or LaTEX manual and will not be discussed here. Rather I will discuss what
has to be done to get the Postscript fonts to appear in the final document with CMacTEX.
The procedures are slightly different for dvips and pdftex, so I will discuss each separately.

Dvips converts the dvi file created by TEX into a Postscript document which can be
printed with a Postscript printer or viewed with ghostview. A dvi file contains no fonts;
it is a device independent page description. The actual Postscript fonts are not used by
TEX . When dvips is converting the dvi file into Postscript it includes the actual fonts
needed by the printer. By default dvips looks for fonts in bitmap (pk) format and it is
necessary to tell dvips that a particular font is a Postscript font. If you don’t, dvips will
try to generate a bitmap font. Since there are no metafont sources for these fonts, dvips
will fail to generate a bitmap font and the Postscript document it produces will not print
correctly. The .map files included with dvips tell it which fonts are Postscript fonts, so
dvips won’t try to generate pk fonts for them. Psfonts.map contains the information dvips
needs when using the “standard” Postscript fonts. Mathtime.map and lucida.map do the
same thing for the MathTime and Lucida Bright fonts. When launched dvips reads the
file “config.ps” and this file tells dvips which map files to read. Dvips writes all of the
information contained in the Postscript font into the Postscript file unless the Postscript
font is treated as a font resident in the printer itself. Most Postscript font vendors make the
files needed by TEX to produce a dvi file freely available. The Postscript fonts themselves
are not freely available.

Pdftex produces a PDF document directly from a TEX source file and, like dvips, it
must include all of the data contained in a font in the final document. By default it also
looks for fonts in bitmap (pk) format and, like dvips, it must be told that a particular font
is a Postscript font. When launched pdftex reads the file “pdftex.cfg” and this file tells
pdftex which map files to read. If pdftex does not include the relevant font information,
the PDF document will not view or print correctly.

12.2 Previewing with Postscript Fonts

Since pdftex produces a PDF document there is no problem previewing the output. Just
launch Acrobat Reader or Acrobat. Since a traditional TEX program produces a dvi file
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you use a dvi previewer to see the output or you convert the dvi file into Postscript and
view it with ghostview.

Dvi previewers were designed to view dvi files with bitmap fonts. Since dvi files only
contain font metric information, major problems arise when bitmap fonts are not available
for viewing. Dvi previewers are not Postscript previewers and don’t know how to handle
the information contained in a Postscript font. There is a particularly elegant solution to
this problem on the Macintosh if you have Adobe Type Manager and the vendor of your
Postscript fonts supplied you with screen (bitmap) versions of its fonts. The MathTime
and Lucida Bright fonts from Y&Y and the Computer Modern Postscript fonts include
such screen fonts. CMacTEX contains the mapping files read by macdvi which tell it
which screen fonts to use for Postscript fonts. Adobe Type Manager and the Mac OS do
the actual work of displaying the fonts. The file “preview.cfg” tells macdvi which map files
to read. Since Adobe Type Manager is not available in OS X you must “enable” your font
suitcases with the “Type 1 Enabler” that used to be distributed with QuickDraw GX. A
few characters in the cmsy and cmbsy fonts don’t display correctly in OS X.

12.3 Computer Modern and AMS Postscript Fonts

The Postscript versions of the Computer Modern and AMS fonts have been made freely
available by Blue Sky Research, Y&Y, and the AMS. Since these fonts are also available
as bitmap (pk) fonts, why bother with the Postscript versions? The answer depends on
the format of your final document. If you only want a Postscript file you can use either
Postscript or bitmap versions. You will have to be careful that the bitmap fonts are created
with a resolution that matches that of your printer and you will have a lot of pk files
on your hard disk, but the final product will look virtually identical either way. If your
final document will be a PDF document you should use the Postscript version of the
fonts for the simple reason that PDF documents with bitmap fonts view very poorly.
When converting Postscript documents to PDF documents make sure that your ps to pdf
converter does not convert Postscript fonts into bitmap fonts.

One potentially confusing issue with the Macintosh screen fonts for the Computer
Modern and AMS Postscript fonts is the fact that the screen fonts are distributed in two
versions, visible and hidden. You can have only one version installed in the Fonts folder
of your System folder. The hidden fonts have the same names as the visible fonts except
their names begin with a %. The hidden fonts do not appear in the Fonts Menu of any
programs but are available for previewing in CMacTEX.
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13 Working with Text Editors

CMacTEX can be fully integrated with either Alpha or BBEdit and it is possible to run most
of the programs from within either of these two popular editors. With Menu selections
in your editor, you can have TEX process the file displayed in the front window, return
automatically to the editor and go to the offending line if TEX detects an error, preview
the dvi file corresponding to the front window (if it exists), convert a dvi file to Postscript
and view the Postscript file. These operations are handled quite differently in Alpha and
BBEdit.

For BBEdit and BBEdit Lite I have written eighteen plug-ins: Convert dvi to ps,
Convert ps to pdf, Goto Error Line, Goto Src Line, latex, Make bib, Make index, Open
Log File, Open Macro File, pdflatex, pdftex, Set Application, Set Typeset Options, tex,
Typeset Front Window, View dvi, View pdf, and View ps. These plug-ins should be
placed in your BBEdit Plug-ins Folder. The plug-ins are for BBEdit 6.x or BBEdit Lite 6.x
and will work in OS X. The plug-ins perform the indicated action on either the .tex file in
the front window, or the dvi file or Postscript file associated with the front window. If you
have returned to BBEdit from tex by typing an ‘e’ at a ? prompt, selecting “Goto Error
Line” will highlight the line tex reported as containing an error. If you are viewing a dvi
file containing \src specials and option-click in a paragraph in a displayed page, macdvi
will tell BBEdit to open the corresponding source file. If you elect “Goto Src Line” BBEdit
will highlight the first line of the selected paragraph. The “tex” plugin calls tex with the tex
format, the “latex” plug-in calls tex with the latex format, the “pdftex” plug-in calls pdftex
with the pdftex format, and the “pdflatex” plug-in calls pdftex with the pdflatex format.
If you wish to use a custom format with either of these tex programs or you wish to use
either etex or pdfetex, set your tex program and format with the “Set Typeset Options”
plug-in and use the “Typeset Front Window” plug-in.

Alpha comes with its own set of commands for interacting with TEX.
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14 Apple Scripts

CMacTEX has always supported the four required Apple events, namely oapp, odoc, pdoc,
and quit, whenever they are a meaningful for a particular program. It also has a suite of
private events used by the various programs to communicate with each other. CMacTEX is
scriptable, although the scripting support is still rather elementary. Most of the programs
now support an event which tries to duplicate the Unix command line interface. If you
are writing Apple Scripts for CMacTEX, use the Script Editor to open the dictionary for a
particular program. Numerous sample scripts are provided with CMacTEX and the easiest
way to learn how to write scripts for CMacTEX is to open one of the supplied scripts with
Script Editor and examine the code.

All apple events specific to CMacTEX have the Event Class ‘CMTX’. The basic script-
ing event has the Event ID ‘exec’ and is supported by CMacTeX, tex, mf, dvips, bibtex,
makeindex, mpost, afm2tfm, dvicopy, gftopk, pktogf, pltotf, tftopl, vftovp, vptovf, psutils,
and t1utils. The event has two parameters. The first parameter has the keyword ‘----’
and must be a string of characters representing a valid Unix style command line. This Unix
style command line cannot redirect input or output and cannot open a pipe to another
process. The second parameter has the keyword ‘dest’ and is a File System Specification
Record for the folder which will be treated as the current working directory. The return
event’s parameter has the keyword ‘----’ and is a long integer designating the exit status of
the program. If successful, the program returns 0 in this parameter; anything else indicates
an error of some sort. Apple Scripts which launched dvips, bibtex, makeindex, pdftex,
and tex in earlier versions of CMacTEX now should launch the CMacTeX program. It will
redirect the Apple Events to the appropriate program.

14.1 Events specific to CMacTeX

Since CmacTeX is the program the user interacts with most, it has several events to make
this interaction easier. Most of the events described below are supported by the BBEdit
plug-ins supplied with CMacTEX.

Typeset a file with a specified format.

Event Class ‘CMTX’

Event ID ‘fdoc’

parameter keyword ‘----’, type FSSpec (file name)

parameter keyword ‘fmat’, type Char (format name)

no return event

Get a list of available formats.

Event Class ‘CMTX’

Event ID ‘frmt’

no parameters

return event’s parameter keyword ‘----’, type Char (a space delimited list of formats)
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Search texinputs for a specified macro file.

Event Class ‘CMTX’

Event ID ’loca’

parameter keyword ‘----’, type Char (name of macro file)

return event’s parameter keyword ‘----’, type Char (name of folder containing the file) If
an empty string is returned, the macro file was not found.
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